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Exercise 1 — Managing data with tables (1)

Creating tables

1. Click anywhere on the data in a sheet

2.

On the Insert menu, click on Table

File Home Insert Draw rmulas  Data  Review View Automate  Help

EI:I ﬁl:l? E m O % (7 30 Models  ~ D]Q dh- [H~

PivotTable Recommended Table Forms | Pictures Shapes Icons 0 SMartArt Checkbox | Recommended 22~ 1

- PivotTables - - - f! Screenshot ~ Charts 9. L~
Tables Illustrations Controls Charts

() SECURITY WARNING External Data Connections have been disabled | Enable Content
G13 ~ fx~  Working towards a goal, Communicating with others
A B c D E F e H 1 J K

1 |Name Prison Prison nun Ethnicity Date of birtAge now  Skills learn Musical ex| Built a rela Enjoyed tht Optimism
2 |Palmira Flc HMP Worn HMP 1277 38787 Working toPlaysamu 2 Agree 3 Didn'ten 2
3 |Banyan Raj HMP Worn HMP 1278 38930 CommunicNot record 2 Agree 1 Reallyen 3
4 |Azalealiu HMP Worn HMP 1279 39038 Focusing o Plays amu 1 Strongly 1 Reallyen 2
5 |Camassia | HMP Worn HMP 1280 39119 Working toPlaysamu 2 Agree 3 Didn'ten 5
6 |Anise River HMP Worn HMP 1281 39197 Building re No musica 3 Disagree 3 Didn't en 4
7 |RueTansy HMP Worn HMP 1282 39242 Improving i No musica 2 Agree 1 Reallyen 2
& |Basilio Che HMP Worn HMP 1283 39292 Working as Plays a mu 3 Disagree 4 Really dic 7
9 |Lemongras HMP Worn HMP 1294 28854 Working toPlays amu 2 Agree 1 Reallyen ]
10 |Lotus Mehi HMP Worn HMP 1295 24924 Improving iPlays amu 2 Agree 2 Enjoyed 5
11 |Magnolia N HMP Worn HMP 1296 32528 Improving i Plays a mu 3 Disagree 2 Enjoyed 3
12 |Maple Flor HMP Worn HMP 1297 35595 Communic Plays a mu 3 Disagree 2 Enjoyed 6
13 |Marigold Fi HMP Worn HMP 1298 23781 Wurkmglc_Plays amu 2Agree 3 Didn'ten 2
14 [Aak Niimna HMB Warn HMD 1900 an294 Frriicing A Dlaue 2 pan 1 Qteandlu 1 Raalluan El

Make sure the whole table is selected by checking the cell range and option My data

has headers is ticked.

el EEE RS
i ~ Maps PivotChart  Line Column Win/ | Slicer Timeline

- - Loss

=] Sparklines Filters
L M N o] P

: Optimism : Change in +Hours boo Hours Atte Difference

3 1 8 7 1

3 0 26 24 2

2 0 4 3 1

6 1 27 26 1

5 1 9 8 1

3 1 11 10 1

5 -2 13 12 1

& 3 10 9 1

7 2 11 11 0

4 1 28 26 2

& 2 18 17 1

3 1 8 7 1

IS A A 2 1

A B C D E F G H | ] K L M N o]
1 jName Prison Prison nur Ethnicity Date of bit Age now  Skills learn Musical ex| Built a rela Enjoyed th Optimism : Optimism s FlkamdainHaves ban Haes Ats Difference
2 {Palmira Flc HMP Worn HMP 1277 38787 Working toPlays amu 2 Agree 3 Didn'ten 2 o Create Table 7 X 1
3 jBanyan Raj HMP Worn HMP 1278 38930 Communic Not record 2 Agree 1 Really en 3 Z S 2
4 1Azalea Liv HMP Worn HMP 1279 39038 Focusing o Plays a mu 1 Strongly 1 Really en 2 4 = 1
5 ICamassia | HMP Worr HMP 1280 39119 Working to Plays amu 2 Agree 3 Didn'ten 5 ¢ SASLSPS29 * 1
6 IAnise River HMP Worn HMP 1281 39197 Building re No musica 3 Disagree 3 Didn't en 4 ¢ @ by table has headers 1
7 JRusTansy HMP Worm HMP 1262 39242 Improving {No musica 2 Agree 1 Reallyen 2 g Cancel 1
8 IBasilio Che HMP Worm HMP 1283 39292 Working as Plays a mu 3 Disagree 4 Really dic 7 5 " . 1
9 |Lemongras HMP Worm HMP 1294 28854 Working toPlaysamu 2 Agree 1 Reallyen 5 8 3 10 1

From the Table Design tab, select the Table style you want to change the look &

feel
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@ rutosve @) [ 9+ U 5 ALTEST Charity Digital Academy - Excel sample data ¢ » Saved + £ Search

File  Home Insert Draw Pagelayout Formulas Data Review View Automate Help Table Design

Table Name: [i5] Summarize with PivotTable [ e Header Row [ First Column Filter Button

[Tablel1 | B} Remove Duplicates % S?ﬁ REZ: i) [ TotalRow [ Last Column

‘B Resize Table & Convert to Range Slicer ~ - Banded Rows (] Banded Columns

Properties Toals External Table Data Table Style Options

(1) SECURITY WARNING External Data Connections have been dissbled | Enable Content |

AL ~ i Jx~| Name

il Name |3 Prison B Prison number Bl Eth B4 Date of birth §d Age now B Skills learnt

2 Palmira Flo HMP Worm HMP 1277 38787 Working tow:

3 Banyan Raj HMP WormHMP 1278 38930 Communicat]

4 Azalealiu HMPWormHMP 1279 39038 Focusing on g

5 Camassia FHMP WormHMP 1280 39119 Working tow: =
6 Anise River HMP Worm HMP 1281 39197 Building relat) =
7 RueTansy HMPWormHMP 1282 39242 Improving ab| =
8 Basilio Che HMP Worm HMP 1283 39292 Working as a

9 Lemongras HMP WormHMP 1294 28854 Working tow:
10 Lotus Mehr HMP Worm HMP 1295 24924 Improving ab)
11 Magnolia N HMP Worm HMP 1296 32528 Improving ab
12 'Maple Flore HMP Worm HMP 1297 35595 Communicat
13 Marigold FitHMP Worm HMP 1298 23781 Working tow:
14 | Oak Dumas HMP Worm HMP 1299 38224 Focusing on g
15 Olive Finch HMP Worm HMP 1300 27677 Focusing on
16 Willow Ferr HMP Worm HMP 1383 22744 Working asa| [ bewTebleStye..
17 Hazel GroviHMP Worm HMP 1384 31339 Communicat| ¥ cer

Data validation
Data validation in Excel is a feature that lets you control what kind of data can be entered
into a cell or range of cells.

Data validation - type

1. Clickinto the first cell of the column where you want to apply data validation

Fle  Home WSt Draw  Fagelayt Formss Dats Redew  View  Aulomats  Help  Table Design

m B0 B Bk [ e o 5 G g0 fifs BB @ af <f
Dite~ Tel/CSV Web  Range Pictwe~ Sources Comnestoms  All- i e i 3 Adances  Cohmns  Fil Duplicates Velidation ~ Model = -

1 ‘Working towseds & gost, Communicating with others Plays
Baryan Raj HMP Wormood Scrubs E ‘Communicating with oths towards a gasl Not recorded 2Agren 1 Raally enjoyed
Assles L HMP Wormwood Scrubs g 1 1 Really snjoyed
Camassia Finto __ HMPWormwood Scrubs 3 i wds a goal, Impravin gh procii Phays a musical instrument_2 Agree 3Didn't enjoy

Anise Rivers HMP Wormmwood Scrubs Nomusical sxperienca 3 Disagres 3Didn’t enjoy
Rua Tansy HMP Wormwaod Scruba ing ability h practica, " Nomusical expecience 2 Agres 1 Really snjoyed
Basilia Chen HMP Wormwood Scrubs Wiorking o5 o tearm, Communicating with athers Phasys a musical instrument_2 Agree 4 Really didn't enjoy

M 1294 Lomangrass Jamos  HME Wormmoo Scrubs 78854 Viorking tewards a gaal, kmpraving abdty through practica Plays a musical instrument_2 Agroo 1 Raally enjoyed
o|1P 1295 Lows Mehra HMP Wormwood Serubs 24924 Improving ot

1M 1296 Magnala Newbe  HMP Wormunos Scrubs 52528 improning

2 |HMP 1297 Mapla Flores. HMP Wormwood Scrubs. 35595

2. Inthe Allow field select Date, in the Data field select greater than in the Start

date putin the earliest possible date e.g. 1/1/2025 as anything earlier would mean

someone over 100 being in the prison.
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Data Validation 7 >

Settings  Input Message  Error Alert
Validation criteria

Allow:

Date - Ignore blank

Data:

greater than W

Start date:

1/1/2025 kS

App Y these L"'an'I\'_.l\'_“L o a | other :.\'_'l S with the same sett '"Il:_'l'_'
Clear All OK Cancel
3. Add an alert to warn them what data is required. This will not stop data entry but

justwarn when itis entered incorrectly. Change the style to warning, putin a title
and give an error message to help users understand what the correct data should

be.
| Data Validation ? >
abled |
| Settings  Input Message | Error Alert _. I
. Show error alert after invalid data is entered
When user enters invalid data, show this error alert
Styhe: Tithe:
Warni " Invalid date
B Eur k (earnt
Error message: ing or

The date of birth entered is either nota & ng tow
— correct date or would make the person B
g as

. aver 100 years old,
f._b. g as

. Ingor
ng rel:
ng tow
ving a
ving a

m 'No musical experience IE‘ruilr:iing rel:

- Clear All oK Carvoel

4|Page



Data validation - List

1. Clickinto the first cell of the column where you want to apply data validation

Fle Hame Imset Draw Pagelayost Fomas Data Redew View Aulomate Help Table Design

GLHLE EDL D

From From Table! _From n
e Comestons

v

Filer

T, Cnhtm ] SR
Tt Flan
Zadances  Cotmes P

St B Fiker

R0

F

= | B @ 62 ¢ @

Cumircies GRgNBhY

o a 4Really diga't enjoy
b |HMP 1294 omongrass James rmevo0d Scrubs T s 1 Really onjoyed

o|1P 1295 r 2Enjoyed
1M 1296 malia Neue oo Scrubs n - 2Enjoyed
2 |HMP 1287 o0 Scrubs s, Working t ? 2Enfayed

2. Inthe Allow field select List. Click in to the Source field and then go to the
Validation lists sheet, highlight the ethnicity list and click on enter on your
keyboard. The worksheet and cell range will then appear in the Source field.

s
| Data Validation 7 X
Input Message  Error Alert r
Validation criteria
Allow:
List . Ignore blank
Data: B n-cell dropdown
between " M
ing o
Source: ﬁ
ng tor
="Validation lists'$A$1:5A%19 t B
ng as
ng as
ing o
O Apply these changes to all other cells with the same settings ngre
ng tor
Clear All oK Cancel Qing i
— Ming i
08/10/1974 'No musical experience Building re
AR MEMOTE hla mmsimimnl rvemnrinman lememems cdem

3. Add an Error Alert to stop people entering anything which is not on the validation
list. In the Style field, select Stop and then in the Title explain why they cannot
enter data.
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| Data Validation ? >

Settings Input Message Error Alert
. Show error alert after invalid data is entered

When user enters invalid data, show this error alert

Style: Tithe:

| Stop v Please pick from the list
. lq
Error message: ir
g
Q k
| hy
-
|
[ My
ny
Clear All oK Cancel 4
— i
ACMANMOTA L S - TR

Conditional formatting

Conditional formatting in Excel lets you automatically change how cells look—
like colors, icons, or data bars—based on their values, so patterns and
important info stand out instantly.

Conditional formatting — Directional

1. Select the Change in Optimism column but clicking in the column header
2. Onthe Home tab, click on the Conditional formatting button and then Icon sets to
pick a directional arrow.
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= Saved v &2 search

Help  Table Design

oL 1 3 AutoSum  ~
Tex [senera | | B | B Bad Good Neutral B o [E= ;
iti = Fill v
- % 9 % 8 F?:r:l:ttt'i‘:‘;al F?r:l':lztfs m Explanatory ... ,Input—‘ Linked Cell Note I"Svm DEIVE& Fm_mat oa
ear ~
1 Mumber = Styles Cells Editing
E Highlight Cells Rules >
fi >
Top/Bottom Rules
ﬁ Data Bars >
G | J K
ﬁ Color Scales >
== Directional
=l lcon Sets 2 rectons :ntor Bl Enjoyed the sessions[Bll Optimism at start (1(bad)-10(good)) Bl Optimism)|
oal, Communicating with others 0 ew Rl * > * * > * 3 Didn't enjoy 2
th others, Working towards a goal mew e Fe—y 4 * F R * 1 Really enjoyed 3
, Working as a team, Communicating with of B Clear Rules > 1 Really enjoyed 2
oal, Improving ability through practice 3 Didn't enjor 5
& proving anllity through p T Manage Rules raue  rAING 1oy
ip with mentor, Working towards a goal ge e AUV 3 Didn't enjoy 4
rough practice, Communicating with others No musical experiency 1 Really enjoyed 2

Conditional formatting — Duplicates
1. Select the Name column but clicking in the column header
2. Onthe Home tab, click on the Conditional formatting button, Select Highlight Cells
Rules and then Duplicate values

File Home Insert Draw Page Layout Formulas Data Review View Automate Help Table Design

ﬁ”] 4 cut [Aptos dn A A = =5 % | 2wepte [Genera || EE | B Normal | a0 Good

[®copy ~ "
Paste B I U i P A = = = = 5= D ] cy L] €0 .00 Conditional | Format as m Eonl P
U v s~ v o = = = | &= 3= ~ % 00 -x0 Explanatory... |Input
= <¥ Format Painter Formatting «| Table
Clipboard F] Font F] Alignment [F] Number 1P

8 EH Highight cetls Rutes > | [T Greater Than...
) SECURITY WARNING External Data Connections have been dissbled | Enable Content | [<] T . =1

i > Less Tha
E Top/Bottom Rules Less Than...

B oot | [ Bt

=] color scales > EFHEI Equal To...
EEE lcon Sets > EI Text that Contains... d

Bl ~ fi~ Name

1
2 |HMP 1277 Palmira Flores HMP Wormwood Scrubs 11/03/2006 Working towards a goal, Com| T New Rule X ument 2
3 [HMP 127§ Banyan Raji HMP Wormwood Scrubs 01/08/2006 Communicating with others, = % ADate Occurring... 2
4 |HMP 1279 Azalea Liu HMP Wormwood Scrubs 17/11/2006 Focusing on atask, Working a| T Clear Rules ument 1
5 |HMP 1280 Camassia Pinto HMP Wormwood Scrubs 06/02/2007 Working towards a goal, Impr B Manage Rules.. Values... ument 2
6 |HMP 1281 Anise Rivers HMP Wormwood Scrubs 25/04/2007 Building relationship with mer — ce 3
7 |HMP 1282 Rue Tansy HMP Wormwood Scrubs 09/06/2007 Improving ability through practice, Communicating with othg ce 2
& |HMP 1283 _Basi‘m Chen HMP Wormwood Scrubs 29/07/2007 Working as a team, Communicating with others rument 2

Conditional formatting — Highlight a whole row based on its value
1. Select the Name column but clicking in the column header
On the Home tab, click on the Conditional formatting button, Select New rule
Select Use a formula to determine which cells to format
In the Format values where this formula is true enter $P2>5
. Clickon Format and select a background colour.

oA w N

7|Page



e LW Ak - L=l Tl e M

mulas T =

Mew Formatting Rule ? *
A Select a Rule Type:
A Co
2 _"t = Farmat all cells based on their values -
= Farmat only cells that contain
| e Format only top or bottom ranked values I
2een disa fy top

77| | = Format only values that are above or below average il
= Format only unique or duplicate values

= Lise a formula to determine which cells to format

Edit the Rule Description:

Format values where this formula is true:
tyﬂ D RRE:F

|

Format...

oK Cancel B
|- .

Exercise 2 — Bringing data together with Power Query

Power Query is a data transformation tool built into Excel and Power Bl that lets you
connectto data sources, clean and reshape data, and automate repetitive tasks—all
without writing code

Creating queries

1. Click onthe table
2. Onthe datatab select From Table/range
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file  Home Insert Draw Page t Formulas Data Review View Automate Help Table Design

[ Queries & Connections a N4 Clear EE @ E C

@ [b [ B [ B o@ o Bromy -

Get  From  From FromTable/  Fr Refresh . ¥ ke G G " z| Sent | Fiter | cappl Textto  Flash  Remove D:

Data~ Tedt/CSV Web  Range  Picture WSources  Connections  All~ [ rganzation oc urrencies  Geography A S Advanced  Columns  Fill  Duplicates Valida
Get & Transform Data Queries & Connections Data Types Sort & Filter Data Too

D16 ~ i fiv

1
2 |Rowan Alder HMP Belmarsh HMP 1234 07/02/1965 Plays a musical instrum Focusing on a task, Working as a team, Communicating wit 2 Agree
3 HazelBramble HMP Belmarsh HMP 1235 23/07/1966 Plays a musical instrum Working towards a goal, Improving ability through practice 3 Disagree
4 |Holly Thorne HMP Belmarsh HMP 1236 14/11/1967 No musical experience Working as a team, Communicating with others 2 Agree
5 Willow Moss HMP Belmarsh HMP 1237 30/04/1968 Plays a musical instrum Working as a team, Communicating with others 1 Strongly agree
6 |Fern Cotter HMP Belmarsh HMP 1238 02/12/1969 No musical experience Focusing on a task, Working as a team, Communicating witk 1 Strongly agree
7 |lvy Brook HMP Belmarsh HMP 1239 19/09/1970 No musical experience Building relationship with mentor, Working towards a goal 2 Agree
8 |Laurel Fenn HMP Belmarsh HMP 1240 03/03/1971 Plays a musical instrum Working towards a goal, Communicating with others 1 Strongly agree
9 PoppyHeather HMP Belmarsh HMP 1241 26/06/1972 Plays a musical instrum Improving ability through practice, Building relationship witk 1 Strongly agree
10 Clover Reed HMP Belmarsh HMP 1242 11/01/1973 Plays a musical instrum Improving ability through practice, Communicating with oth 1 Strongly agree
11 |Sorrel Ash HMP Belmarsh HMP 1243 08/10/1974 No musical experience Building relationship with mentor, Working towards a goal 2 Agree
12 |Primrose Tilling HMP Belmarsh HMP 1244 25/05/1975 No musical experience Improving ability through practice, Building relationship witt 3 Disagree
13 Foxglove Banner HMP Belmarsh HMP 1245 15/08/1976 Plays a musical instrum Building relationship with mentor, Working towards a goal 3 Disagree
14 |Bluebell Harrow HMP Belmarsh HMP 1247 06/11/1977 No musical experience Improving ability through practice, Communicating with oth 2 Agree
15 Baobab Moyo HMP Belmarsh HMP 1247 18/02/1978 No musical experience Improving ability through practice, Communicating with oth 3 Disagree
16 |[Tamarind Ellis ~ HMP Belmarsh HMP 1248 _09/07/1 979 Plays a musical instrum Communicating with others, Working towards a goal 2 Agree
17 |Rirrh Taneu HMD Ralmarch HMP 1214 2a/nA/1a5a Plaue a musical instrim Warking ae o tasm Camminicstingwith athare 9 Baraa
3. Checkthe query has the prison name
4. Onthe home tab, select Close and Load to
Py [ 2 Properties L Y EeE 4 ¥ 1 Data Type: Text ™ [ Merge Queries ~ =] [ New Source
=] e : X HH nn = ; = : 8 .
= & | 2 Advanced Editor L - Il [ Use First Row as Headers * = Append Queries ~ L Recent Sources ™
Close & Refresh . Choose  Remove Keep Remave split  Group , , , ., Manage  Data source
Load~ | Preview~ £5 Manage Columns ™ Columns = Rows ™ Rows ™ Column= By 2 ReplaceValues el = Parameters®  semings L3 Enter Data
2] Close & Load v lumns Reduce Rows  Sort Transform Combine Parameters  Data Sources New Query
23 Close & Load To.. le HMP Belmarsh HMP 1235 null 23/07/1966 00:0¢"_ [PE—
HMP Belmarsh HMP 1236 nuil 14/11/1967 00:0C -

4 Willow Moss HMP Belmarsh HMP 1237 null 30/04/1968 00:0C All Properties

5 Fern Cotter HMP Belmarsh HMP 1238 null 02/12/1969 00:0C 4 APPLIED STEPS

6 Ivy Brook HMP Belmarsh HMP 1239 null 19/09/1970 00:0¢

7 2 HMP Bels h HMP 1240 il 03/03/1971 00:0C source

L Imar: nul X
aurel Fenn elmars - X Changed Type

8 Poppy Heather HMP Belmarsh HMP 1241 nuil 26/06/1972 00:0C

9 Clover Reed HMP Belmarsh HMP 1242 null 11/01/1973 00:0¢

10 Sorrel Ash HMP Belmarsh HMP 1243 null 08/10/1974 00:0C.

11 Primrose Tilling HMP Belmarsh HMP 1244 nuil 25/05/1975 00:0C

12 Foxglove Banner HMP Belmarsh HMP 1245 nuil 15/08/1976 00:0C

13 Bluebell Harrow HMP Belmarsh HMP 1247 null 06/11/1977 00:0C

5. Under the Import data options select Only Create Connection
6. Clickon OK
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- i L

Cueries & Connections Data Types
y through practice, Commun |mport Data 7 e
Select how you want to view this data in your workbook.
I:I () Table
C D () PivotTable Report

| number B Ethnicity R DAY o=t B sills learnt |
234 o9 = © [only Create Connection, itrum Focusing on a task, V
235 E Where do you want 1o put the data? ﬂm Working towards a gc
236 14 Existing worksheet :nce Working as a team, C
237 ﬂ SHEaS 4 itrum Working as a team, C
238 02 :nce Focusing on atask,V
239 E e snce  Building relationship
240 ~ 03 (] Add this data to the Data Model itrum Working towards a gc
241 26 itrum Improving ability thre
242 E Properties i E‘n Improving ability thrc
243 08/TOF 1974 I NEmdsical experience Building relationship
244 2R/IDRMATR MNa muszical avneriencre lmnrowving ahilite thee

7. Repeat forthe other 3 Prisons

Appending queries

1. Open the Query editor on the Data tab by going to Get Data and selecting Launch
Power Query Editor.

File Home Insert Draw  Page Layout Formulas Data Review View  Automate  Help
[ Queries & Cannections
EDDRE BD B [Osm—
From  From FromTable/  From  Recent Existing Refresh 0
|Data ~ | Tewt/CSV  Web Range  Picture~ Sources  Connections Al D r9a
D From Eile y @ Queries & Connections
[% From Database >
>
& From Azure C D E E
E From Fabric & Power Platform >
1 hd Prison ﬂEIhnicityﬂ Date of hirthﬂAge now|
2 [34, From Other Sources > [ HMP Wormwood Scrubs 38787
3 | HMP Wormwood Scrubs 36930
4 % Combine Queries HMP Wormwood Scrubs 39038
5 rmwood Scrubs 39119
6| BF Launch Power Query Editor... rmwood Scrubs 39197
7 B ormwood Scrubs 39242
g| L# DataSourceettings.. | HMP Wormwood Scrubs 39292
9 Query Options 3 HMP Wormwood Scrubs 28854
10T TZoT TOTUS ToTErNT S “ HMP Wormwood Scrubs 24924
11 [HMP 1296 Magnolia Ncube HMP Wormwood Scrubs 32528
12 |HMP 1257 Maple Flores HMP Wormwood Scrubs 35595
13 [HMP 1298 Marigold Finch HMP Wormwood Scrubs 23781
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2. Onthe Home tab, select the option Append Queries as New

M - s  HMP Belmarsh - Power Query Editor =] X
Home  Transform Add Column  View - @
P | [ Properties ‘ J Y R 4 ] o DawTypeTex~ [ Merge Queries = ] ) [ New Source =
s & [hadencedEdior X HHHH 2 T = e fist Rowss Headers = ([ Append Querieds :
CLluse & Refresh — Choose  Remove  Keep Remove split  Group , I o | Apperst ueries
cad~  Preview Columns~ Columns®  Rows= Rows™ Column~ By %
Close Query Manage Columns Reduce Rows  Sort Transform T, Append Queries as New
2 Hazel Bramble HMP Belmarsh HMP 1235 null null Plays a musical ir,
&0 HMP_Wormwood_Sc 3 Holly Thome HMP Belmarsh HMP 1236 null 4/11/1967 00:00-00 null| No musical exper
4 willow Moss HMP Belmarsh HMP 1237 null 30/04/1968 00:00:00 null Plays a musical ir
5 Fern Cotter HMP Belmarsh HMP 1238 null 02/12/1969 00:00:00 null| No musical exper
6  Ivy Brook HMP Belmarsh HMP 1239 null 19/09/1970 00:00:00 null No musical exper
7 Laurel Fenn HMP Belmarsh HMP 1240 null 03/03/1971 00:00:00 null | Plays a musical ir
8 Poppy Heather HMP Belmarsh HMP 1241 null 26/06/1972 00:00:00 null Plays a musical ir
9 Clover Reed HMP Belmarsh HMP 1242 null 11/01/1973 00:00:00 null | Plays a musical ir
10 Sorrel Ash HMP Belmarsh HMP 1243 null 08/10/1974 00:00:00 null No musical exper
11 Primrose Tilling HMP Belmarsh HMP 1244 null 25/05/1975 00:00:00 null| No musical exper

3. Select the 4 Prison queries by clicking on them and then on Add>> so that all 4
queries are in the Tables to append box

bome Tosom  ddColurm  view

Queries [4] < | fx ” = Table.TransformColumnTypes(Source,{{"Name", type text}, {"Prison", type text}, {"Prison number", type any}, {"Ethnicity"”, type

i) OO Pet =1, A8 Name [~ ] A% prison [~ ] 155 Pprison number 45 Ethnicity [~| % Date of birth [~ 155 Agenow

F5 HMP_Brixton
1 Rowan Alder HMP Belmarsh HMP 1234 null 07/02/1965 00:00:00 n

[ HMP_Manchester
2 Hazel Bramble HMP Belmarsh HMP 1235 null 23/07/1966 00:00:00 n

5 HMP Wormwood Sc... 3 Holly Thorne HMP Belmarsh HMP 1236 null 14/11/1967 00:00:00 r
4 Willow Moss HMP Belmarsh HMP 1237 null 30/04/1968 00:00:00 n
5  Fern Cotter HMP Belmarsh HMP 1238 null 02/12/1969 00:00:00 n
6 vy Brook ' . ' « poo r
7 Laurel Fenn 0:00 n
8 popoyeate  APPENd boo .
9  Clover Reed Concatenate rows from three or more tables into a single table. p:00 n
10 | sorrel Ash OTwotables  © Three or more tables E !
11 Primrose Tillin, p:00 n
12 Foxglove Banni Available tables Tables to append 0:00 n
13 {BiGct= gl HMP_Belmarsh HMP_Belmarsh | "
14 fEsohabivois HMP_Brixton HMP_Brixton | ’
15 NemerindiEiy HMP_Manchester HMP_Manchester - g
16 [ELlEy HMP_Wormwood_Scrubs HMP_Wormwood_Scrubs I)OO 4
17 Ginger Vale Add >> 0:00 n
18 Marigold Finch| DOO n
19 Flamboyant Pal ﬂOD n
20 Baobab Moyo DOO n
21 Hawthorn Evel DOO n
22 Sprigleong DOO n
23 Taro Hollis DOO n
24 Cassava Rivera Cancel ﬂOD n
25 Yam Dumas D:00 n
26 Kapok Anand DOO n
27 Mahogany Silva HMP Belmarsh HMP 1325 null 24/06/2000 00:00:00 n
28 lacaranda Ndlavu HMP Relmarsh HMP 1226 null 22/01/1962 00:00:00 n

4. Clickon OK
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5. Anew query will appear on the left called Append1

Queries [5] <

T HMP_Belmarsh

Transform Add Column

fx

View

= Table.Combine({HMP_Belmarsh, HMP_Brixton, HMP_Manchester, HMP_Wormwood Scrubs})

ABC

. A% Name ~ | A8 Prison ~ | 135 Prison number ~ | 155 Ethnicity v 923 [
FH HMP_Brixton
1 Rowan Alder HMP Belmarsh HMP 1234 null
 HMP_Manchester
2 Hazel Bramble HMP Belmarsh HMP 1235 null
= HMP_Wormwood_Sc... horne HMP Belmarsh HMP 1236 null
] Appendt Moss HMP Belmarsh HMP 1237 null
5 Fern Cotter HMP Belmarsh HMP 1238 null
6  Ivy Brook HMP Belmarsh HMP 1239 null
7 Laurel Fenn HMP Belmarsh HMP 1240 null
8 Poppy Heather HMP Belmarsh HMP 1241 null
9 Clover Reed HMP Belmarsh HMP 1242 null
10 Sorrel Ash HMP Belmarsh HMP 1243 null
11 Primrose Tilling HMP Belmarsh HMP 1244 null
12 Foxglove Banner HMP Belmarsh HMP 1245 null

6. Double click on Append 1 or right click and select rename, and rename it to All

participants

Transform Add Column View

Queries [5] < ﬁc

= Table.Combine({HMP_Belmarsh, HMP_Brixton, HMP_Manchester, HMP_Wormwood_Scrubs})

HMP Belmarsh

7. Onthe Home tab click on the Close & Load button

Home Transform Add Column View
far Ij EE Properties |:| LB
I |
E =~ [.LI:‘F Advanced Editor x
Refresh Choose  Remove

Preview ¥ & iianage Columns ¥ Columns ~

Close &
Load ~

aﬁ Close & Load ‘ Manage Columns
T4 Close & Load To.. zel Bramble
e lly Thorne

£ Al participants Willow Moss
5 Fern Cotter

6  Ivy Brook
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i |

EER
z
al
Keep Remove
Rows™ Rows~

Split
Column =
Reduce Rows Sort

HMP Belmarsh

HMP Belmarsh
HMP Belmarsh
HMP Belmarsh

HMP Belmarsh

dh =

Group

By

Data Type: Text ™

D Use First Row as Headers ~
%, Replace Values

Transform

HMP 1235

HMP 1236

HMP 1237

HMP 1238

HMP 1239

02/12/1969 00:00:00

Ej‘ Merge Queries ~
Z Append Queries ~
Combine Files

Combine

3 HMP_Belmarsh
T, ABc Name ~ | A%c Prison ~ | 455 Prison number ~ | 155 Ethnicity ~ | $55 Date of birth ~ | 35 Age now

FH HMP_Brixton

1 Rowan Alder HMP Belmarsh HMP 1234 null 07/02/1965 00:00:00 n
B HMP_Manchester

2 Hazel Bramble HMP Belmarsh HMP 1235 null 23/07/1966 00:00:00 n
F HMP_Wormwood g orne HMP Belmarsh HMP 1236 null 14/11/1967 00:00:00 m
F Al participants| Moss HMP Belmarsh HMP 1237 nulf 30/04/1968 00:00:00 n

HMP 1238 nult n



8. You should now have a new sheet called All participants in your workbook

19 |Mahogany Shaw HMP Brixton HMP 1252 30321 No musical experience It
30 |Sakura Inoue HMP Brixton HMP 1253 31006 No musical experience v
31 |Lotus Mehra HMP Brixton HMP 1254 31165 Plays a musical instrument E
32 |Bamboo Tanaka HMP Brixton HMP 1255 31640 No musical experience v
33 |Maranta Leong HMP Brixton HMP 1256 32118 MNo musical experience B
34 |Plumeria Anand HMP Brixton HMP 1257 32205 MNot recorded v
35 |Ginger Kiri HMP Brixton HMP 1258 32795 Plays a musical instrument E
36 |Ash Rowan HMP Brixton HL® 1284 28960 Plavs a musical instrument C

< > Guidelines Al participants

rison 2 Prison 3 Prison 4 Validation lists Prison info Sum

Adding source data and refreshing queries

1. Add arow of data for a new participant to any of the 4 prison tables
2. Refresh the query either individually by clicking on the refresh icon next to the query
name

We o Homt el Db MGRLOW  Formuls DBls Reem Vi  idomale  Hep

GREE BDR b RE===) o o o (|87 EME S @ BE EAE

0 ool W M v s consge cop || 1 T | e e g et e | o e
T E
(M tome Bfrisen Bl Prison numises B Eshiciy Bl Date of birin Bl Ape now B = ] o <)) 1 Char] A
ity i =1 =5 ; :
e S e : 3
AT i - s - .
B s : g =T :
HMF 1318 HB8NSTE 2Enjoyed ] 3
it it 5 g
e C : T : 0
HMP 1346 110172006 i ce. ool 1 Strongly agree. 4 Reasliy didn't snjoy 2 &
o e —— : :
I

File Home Insert Draw  Page Layout  Formulas

Bl E B

Get From  From From Table/ From

Review View  Automate Help

e 1 CE T o
Refeh == i 2 g E‘ 2| st e % %mg

Data~ Tet/CSY Web  Range Picture~ Sources Conn Al B Organization  Stocks  Currencies  Geography 9 Advanced | Columns
Get & Transform Data Queries & Connections Data Types Sort & Filter
F50 v o fe

ﬂ Prison Prison number ﬂ Ethnicityﬂ Date of hirthﬂ Age now ﬂ Musical experience ﬂ Skills learnt
Rowan Alder HMP Belmarsh HMP 1234 07/02/1965 Plays a musical instrum Focusing on a task, Working as a team, Communicating witk 2 Agree

1
2

3 Hazel Bramble HMP Belmarsh HMP 1235 23/07/1966 Plays a musical instrum Working towards a goal, Improving ability through practice 3 Disagree

4 |Holly Thorne HMP Belmarsh HMP 1236 14/11/1967 No musical experience Working as a team, Communicating with others 2 Agree

5 Willow Moss HMP Belmarsh HMP 1237 30/04/1968 Plays a musical instrum Working as a team, Communicating with others 1 Strongly agr
6 |Fern Cotter HMP Belmarsh HMP 1238 02/12/1969 No musical experience Focusing on a task, Working as a team, Communicating witk 1 Strongly agr
7 Ihv Brook HMP Realmarsh HMP 1239 19/09/1970 No musical experiance Building relationshin with mentor. Working towards agonal 2 Adrea
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Exercise 3: Managing data with tables (2)

Adding totals

Adding a total row

1. Click anywhere on the table to select it
2. Onthe Table Design tab, tick the Total row box

] Header Rew
=] Total Raw

| Banded Rows

1161 ~ fx 1Strongly agree
Mame ~|Prisan ~| Prisan number [~ |Ethnicity [ -] Dateof birth |+ ] Age now | - | Musical experience ~| Skills learnt ~| Bullt a relationship with their mentor [~ | Enjoyed -] Optimism
112 Dandelion Plke  HMP Manchester HMP 1274 38492 Plays a musical instrument_Improving abili practice, Building ip with mentor 3 Disagree 2Enjoyed
113 Tamarindo Reyes HMP Manchester HMP 1275 38541 Mo musical experience _ Building relationship with mentor, Working towards a goal 1Strongly agree 2 Enjoyed
114 Kapok Okoro HMP Manchester HMP 1276 38651 i 3 Disagree 2 Enjoyed
115 Hawthorn Everly  HMP Manchester HMP 1290 37658 3 Disagree 2 Enjoyed
116 vy Brook HMP Manchester HMP 1291 34984 4 Strongly disagree 4 Reallydidn't enjoy
117 |Kapok Anand HMP Manchester HMP 1292 31900 3 Disagree 2 Enjoyed
118 Laurel Bambara  HMP Manchester HMP 1295 24336 strument_Building relati rking towards agoal 2 Agree 2 Enjoyed

Selecting a type of total

1. Clickinthe total row in the column where you want to add a calculation and select it
off the list

Adding formulas with Flash Fill
1. Add aformula in the first cell of the column where you want the formula
2. Dragitdown afew cells
3. Right mouse click and select Flash fill to have the formula populate all the way down

agaal
menunicating wit athers.
ommunicating with athers 3 Disagres
agast 2 hgren

s

Impravng abilty through

Wor

PN N A A TN A PN

18 36323

19| s1764

20| 24051 4 Rsally didn't enjoy
21| 2% 2 Agres 1 Ry snyoyed

22| 28883 3 Disasree 2 Eniowed

Exercise 4: Pivot Tables & Charts

Pivot tables are a feature in Excel and Power Bl that lets you summarise, explore, and
analyse large datasets quickly and interactively — without writing formulas from scratch.

1. Usingthe All participants sheet, insert a Pivot table (Insert tab and select the
PivotTable)
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2. Name the Pivot Table ‘Enjoyment’ (see top left of PivotTable Analyse Tab, or click
down arrow under PivotTable Command)

3. Selectthe following fields in the PivotTable Fields list on the far-right of your screen:
Prison, Prison number, Enjoyed the sessions (/f you don’t see these options, make
sure you have clicked somewhere in the PivotTable on the left)

4. Drag ‘Prison’ to Columns; drag ‘Prison number to Values; drag ‘Enjoyed the
sessions’ to Rows. Check the Values is showing as ‘Count of Prison number’.

Drag fields between areas below:

Y Filters Il Columns

Enjoyed the sessions v

Rows Z Values

Prison v Count of Prison number v

5. Now change the Value Field Settings to show as % of Row Total (Click on the down
arrow next to ‘Prison ID’ in the Values quadrant and choose % of Row Total from the
‘Show Values As’ tab)

Source Name: Prison number

Custom Name:  Count of Prison number
Summarise Values By  Show Values As
Show values as
t

% of Row Total

6. Remove the decimal places (Highlight the cells with % in them in the PivotTable, go
to the Home Tab, Number Group, and select the Decrease Decimal command twice
to remove decimal places (using the right arrow icon)

7. Rename the new Sheet to ‘Enjoyment Pivot’ (Double click Sheet tab at the bottom to
rename)

8. Now repeat the above choosing Built a relationship with their mentor in place of the
Enjoyed the sessions, renaming the new sheet created ‘Relationship Pivot’.

9. Using the Relationship pivot, click on the Pivot table analyse tab and then select
Pivot Chart on the top menu (towards the right). Create a Stacked bar chart to
compare the prisons performance.
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Count of Prison number

HMP Wormwood Scrubs

Built a relationship with their... -
HMP Manchester
| 1 Strongly agree
Prison ~ 2 Agree
HMP Brixton m 3 Disagree

4 Strongly disagree

HMP Belmarsh

0% 20% 40% 60% 80% 100%

10. Add the Musical experience field to the Filter area of the Pivot table - this should
now appear on your chart. Do the building a relationship with your mentor results
differ depending on whether participants did or did not have prior musical
experience?

Exercise 5: Bringing data from one sheet to another

The GETPIVOTDATA() formula in Excel is like a smart query tool that lets you pull specific
values from a PivotTable based on its structure—not just cell location

1. Inthe Summary sheet, create a Get Pivot Data formula in the top cell of the
Enjoyment Column (for Belmarsh Prison) by clicking in the cell and entering =

2. Then go to the Enjoyment Pivot Sheet and click on the cell with the results for
Belmarsh prison and ‘1 Really Enjoyed’. Now click on the + sign and click the cell
with the results for Belmarsh prison and ‘2 Enjoyed’. Press Enter.

3. Copy this formula to remaining rows and you’ll see an error. In the Formulae in the
next cell down change the Prison name to “HMP Brixton” (type this in, in the formula
bar, overriding HMP Belmarsh in the 2 places it occurs in the formulae)

4. Inthe next cell down, this time remove the Prison name (including the speech marks
“”)and replace with the cell reference for the Prison name (in the Prison columnin
the Summary sheet) that you want to replace it with (in this case HMP Manchester —
cell A6) Again, you will need to do this twice — for each instance that the Prison name
occurs in the formula.

5. Now copy the formula down to the Wormwood Scrubs row and check the answer is
correct

6. Repeat for the Built a relationship with their mentor data
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Using Xlookup

This formula searches a range or an array for a match and returns the corresponding item
from a second range or array. By default an exact match is used.

7. Inthe Summary sheet, use Xlookup to bring in data for the respective prisons from
the Prison info sheet into the Number of mentors column.
8. Follow the Xlookup format below

XLOOKUP(lookup value, lookup_array, return_array, [if_not_found], [match_mode], [search_mode])

For this scenario you’ll need to use =XLOOKUP(A4, 'Prison info'!A:A,'Prison
info'!F:F) and then copy the formulae down.

Using Countif
This Counts the number of cells within a range that meet the given condition.

9. Stillinthe Summary sheet, use the Countif formula to bring in data for the
respective prisons from the Prison info sheet into the Number of mentors column.
10. Follow the Countif format below

COUNTIF(range, criteria)

For this scenario you’ll need to use =COUNTIF(ALL_participants[Prison], ' Summary
sheet'!A4)
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